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Chapter 1
Introduction

Welcome to Sharpdesk! This software offers you acomplete, easy-to-use solution for organizing
and working with your paper and e ectronic documents and images. Once a document has been
saved to your PC, you can use Sharpdesk to organizeiit, view it, and then print it or e-mall it.
Sharpdesk integrates the tools you need.

This User’s Guide describes the standard features of Sharpdesk. Sharpdesk a so works with other
Sharp products that might add new capabilities to Sharpdesk that are not included in this Guide.
The details of these new capabilities are described in the literature that comes with the Sharp
product that “linksin” to Sharpdesk.

Sharpdesk User’s Guide 1



Overview
Working with Sharpdesk, you can:

Scan Images and Documents [ Sharpdesk works with your scanner to let you read paper
documentsinto your PC using al of the scanning controls and options provided with your
TWAIN scanner or Sharp copier with the Network Scanner Tool option. Sharpdesk provides
you with both “simple” scanning options aswell as“advanced” options, giving you full
control over scanning preferences.

Convert Imagesto Text O Text images scanned into Sharpdesk can be converted into
editable text for use with common word processors. Sharpdesk uses an advanced Optical
Character Recognition (OCR) engine that even preserves your document layouts. You can
also convert an image containing text into aword processing format by smply dragging it
from any folder onto the Sharpdesk Output Zone.

Prepare Production Ready Documents [0 Using Sharpdesk Composer, you can combine
files of different typesinto a single production-ready document. For example, combine a
Word® file with an Excel® file and then add in aLotus® file. In general, any application that
can send documents to a printer can contribute pages to a Composer document. Reorder
pages as you want them to appear and then print the entire document into stapled sets,
making asingle trip to the printer to collect your new documents.

View Your Images [1 Using Sharpdesk Imaging, viewing your stored images, scanned
images, and digital cameraimagesis quick and easy.

Distribute Your Documents [0 Distribute documents by e-mail or print a hard copy as easily
asdragging afile onto an icon on the Sharpdesk Output Zone.

Import/Export an Image or Document [J Import, store, and manage .BMP,..JPG .PCX, or
.TIF documents and images directly from Sharpdesk.
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System Requirements

To successfully ingtall and use Sharpdesk, your system must meet the following minimum
requirements:

An Intel processor-based PC, PentiumJ 133 MHz or greater (Pentium MM X 200 MHz or
better recommended)

Microsoft Windows 95

Microsoft Windows 98

Microsoft Windows Millennium

Microsoft Windows NT® 4.0 Workstation with Service Pack 4 or later
Microsoft Windows 2000 Professiona

Microsoft Windows XP Professiona / Home Edition

Internet Explorer 5.0 or later. Sharpdesk will ingtall aminimal version of Internet Explorer
5.01if thisrequirement is not available on your system.

At least 32 megabytes (MB) of RAM. (64MB or more recommended to increase processing
Speed))

At least 110 MB of available hard disk space

SV GA monitor, 800 x 600 resolution, 256 colors (True Color recommended)

An Internet connection to access Sharp Internet product support sites.
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About This Guide

This User’s Guide assumes you have a bas ¢ understanding of Windows operation and are familiar
with Windows terms. Thisincludes how to start your system and navigate within aWindows
environment, and perform such basic Windows functions as copying, printing and moving
documents.

For assistance in using Windows or Internet Explorer, refer to your Microsoft Windows user
documentation.

User’s Guide Organization

This user’s guide is organized into the following chapters:

Chapter 1, Introduction
A basic overview of Sharpdesk features, options, system requirements, and User’s Guide
organization.

Chapter 2, Installing Sharpdesk

Reviewsthe ingtallation process and how to uningtall the software.

Chapter 3, Sharpdesk Overview
This chapter looks at how to navigate and work within Sharpdesk, including its menu and tool bar
options.

Chapter 4, Working with Sharpdesk
This chapter explains how to change the view of your images and documents in Sharpdesk, and
how to organize them, including how to open, save, copy, and move documents.

Chapter 5, Scanning with Sharpdesk
Reviews Sharpdesk scanning options and controls including how to select a scanner, scan an
image into Sharpdesk, and set scanning options.

Chapter 6, Converting Images to Text
This chapter shows you how to convert an image into aformat you can use with your favorite
word processor and provides afew helpful hints on what you can do once it has been converted.

Chapter 7, Sharpdesk Composer
Creating production-ready documents could not be easier with Sharpdesk Composer. This chapter
shows you how to combine documents, re-order documents, and print afinal document.

Chapter 8, Sharpdesk Imaging
Thetoolsfor viewing images are reviewed in this chapter, including adjusting the view of images,
printing images, and adjusting Imaging default options.

Chapter 9, Glossary
List of terms used in this Guide or related to image processing.
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Definitions of Terms
Asyou work with Sharpdesk, keep in mind how the following terms are used:

Images
In Sharpdesk, the term Image refers to items that can be loaded into Imaging.

Devices
A deviceisapiece of hardware such as a scanner, printer, fax machine, digital cameraor copier.

OCR
Optical Character Recognition (OCR). A technology that lets you convert an image into aform
that is compatible with common word processors.

Sharpdesk Online Help

The online help provides step-by-step ingtructions for performing Sharpdesk tasks. You can access
the online help by using the Help menu in each application.

Sharpdesk User’s Guide 5
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Chapter 2
Installing Sharpdesk

Installation Procedure

Installing the Sharpdesk software is smple and straightforward. When you install Sharpdesk, the
entire suite of Sharpdesk applications, including Sharpdesk, Composer, and Imaging, isloaded
into your PC.

Software Location

By default, the Sharpdesk software isinstalled on your default boot drive (usualy C: \ ) in afolder
named Sharpdesk (the full pathisC: \ Pr ogr am Fi | es\ Shar p\ Shar pdesk\ ), unlessyou
specify another drive and/or folder during installation. The installation process aso changes some
of your system filesto allow al the Sharpdesk components to work properly.

User File Location

You can aso specify the location of where to store the documents and images you work onin
Sharpdesk. Unless otherwise specified, the installation program creates anew Shar pdesk
Deskt op folder and subfolders on the default boot drive (usualy C: \ ). If you specify another
location for your datafiles, you should not assign them into the same folder (or sub-folder) asthe
Sharpdesk software, since all Sharpdesk software folders will be deleted if Sharpdesk is ever
uninstalled.

Sharpdesk User’s Guide 7



Sharpdesk CD Installation
Toingal Sharpdesk fromaCD:

1. If any Windows applications are open, close them to ensure that the software installs properly.
In particular, anti-virus programs such as*“Norton AntiVirus’ may report false warningsif
they are not disabled prior to installation.

2. Insert theingtallation CD into your CD-ROM drive. Inafew moments, the installation
Welcome screen automatically appears on your monitor screen. If the Welcome screen does
not appear (for example, because you have disabled the Windows Auto Run feature), run the
Setup.exe program located in the\ Shar pdesk directory on the CD.

NOTE: If the CD supports multiple languages, you need to choose alanguage first.

Welcome to Sharpdesk LT installation X|

YWelcome to the “'Metwark Scanner Expansion Kit'
Setup program.  Thiz program will install "Mebworl,
- Scanner Expanszion Kit'" on your computer.

[t ig gtrongly recommended that you exit all wWindows programs
before minning thiz Setup program.

Click Cancel to quit Setup and then cloze any programs pou
have running. Click Mest o continue with the Setup program.

WARMIMG: Thiz program iz protected by copyright law and
international treaties.

IJnauthonzed reproduction or digtnbution of thiz program, or ary
portion af it, may result in zevere civil and criminal penalties, and
will be progecuted ta the magimum extent poszible under law.

Cancel |

Sharpdesk Installation Welcome Screen

3. Follow the on-screen ingtructions to complete the instal lation.

4. Oncetheingdlation completes, you might be prompted to restart your computer. If so
instructed, you must restart your computer in order to use the Sharpdesk

During ingtallation or, if required, when restarting your computer, afolder is created in your
Program Files directory or the location you specified during installation containing al the
Sharpdesk, Composer, and Imaging software files. You will also find a Sharpdesk entry added to
your Start/Programs menu containing the Sharpdesk and Imaging softwarefiles. Finaly, a
Sharpdesk LT shortcut is placed on your desktop making access to the software very convenient.
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Uninstalling Sharpdesk

If you need to uningall Sharpdesk, you can do so using the following standard Windows
procedure for uninstalling software.

1. Click the Windows Start button, then Settings and Control Pandl.
2. Double-click Add/Remove Programs.

B Al Remnoser Progeams =10 =]

Currently retalied programs Sort baes| Nama ;l
E-} Adaba Adrobet 500 ] 53 24E ﬂ

-. Sharpdesk LT

Used
Last Lsed On

Tin charegs: Ehis prcs
computer, chok Changef®

A [Ramonwe
Wi

omporeErts

Clgse |

Add/Remove Programs Properties Dialog Box

3. Inthe Add/Remove Programs Properties dialog box, scroll down the software list and click on
Sharpdesk LT.
4. Click Add/Remove.

5. When the confirmation message displays, click Yesto complete the Sharpdesk uningtdlation.
Note that the uninstall process will not delete the folder named to hold the Sharpdesk data
files (by default, C:. \ Shar pdesk Deskt op) sdected during theingtall process.

6. When complete, click OK to close the Add/Remove Programs Properties dialog box.
The menuitem, “Uninstall Sharpdesk”, in the Windows startup menu also launches this process.

NOTE : If you uningtall Sharpdesk Imaging, you may lose your viewer for imagefiles. Imaging
for Windows, which can be ingtalled using “Windows Setup” tab in the “ Add/Remove Programs
Properties Dialog Box” above, can beingalled from Microsoft mediato serve asyour image
viewer.
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Chapter 3
Sharpdesk Overview

Introduction

Sharpdesk is aWindows application that providesintegrated organization for al your paper and
el ectronic documents and images. With Sharpdesk, you can:

e Scan and view documents

*  Convert imagesinto text documents

*  Organize documents and images among Windows folders
* Digtribute documents by e-mail

Sharpdesk makes working with the devices connected to your computer (scanner, printer, or
digital camera) more efficient, easy, and productive than ever before.
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Starting Sharpdesk

You can gart Sharpdesk from the Windows Start menu by clicking Start, pointing to Programs,
then to Sharpdesk, and findly clicking Sharpdesk LT.

You can aso gart Sharpdesk from the Windows desktop by double-clicking the Sharpdesk LT
shortcut icon.

:3 & harpednzk
Flo [l Viess Jook [nierel Hep < Menu Bar
> | = & E Y
Toolbar ﬁ G Eaan
_ | dunicies

1 Bl
| Bz Fasoar
| | mpostant [0 posrents
] R
i RATTEE S

¢ |1 Peseral

- T

) i@ @ e

Folder
Window
Corres By
och \
Work Area @
Corposs
Output
zone
apphcann
Status Bar
Fimady HUM &

Sharpdesk Main Window

Folders and files are selected by clicking on them in the Folder Window or in the Work Area.
Once selected, you can display information or execute commands by right-clicking on them. Or,
you can choose a command from the Menu Bar, Toolbar, or Output Zone. Sharpdesk providesyou
with aconvenient way of viewing, organizing, and distributing your files.

Sharpdesk is comprised of the following e ements:

Menu Bar

The menu bar contains al the commands that are available in Sharpdesk, from opening and
displaying documents to accessing product support on the Internet.

Folder Window

The Folder Window lets you access your files and system resources. It can be used much like
Windows Explorer to locate and display information from Sharpdesk or your Folder/Drive.

Toolbar

The toolbar provides quick accessto key commands and other Sharpdesk applications such asthe
Sharpdesk Composer and Imaging.
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In circumstances where a command or application is not possible, the toolbar button is dimmed
and unavailable for selection.™ To see what atoolbar option can do, place the mouse pointer
directly over the toolbar icon and atool tip appears explaining the function of that option.

Work Area

The work area displays the contents of a selected folder in athumbnail view. From the work area,
you can select afileto work with, and then view it, convert it to text, or print it.

Output Zone

The Sharpdesk Output Zone displaysicons for various destinations you can send filesto. The
Output Zone lets you print, fax, e-mail, convert imagesto text, and passfiles to other applications
of your choice with asimple drag-and-drop operation.

Status Bar

The status bar displaysinformation about a selected file in addition to command and tool bar
definitions. The definitions appear when you move the mouse pointer over acommand or toolbar
option. Thisis standard Windows status bar behavior.

Scroll Bars

If the contents of the Folder Window or the Work Area are more than can be displayed in the
current window, Sharpdesk provides scroll barsthat let you view al the available information.

NOTE -*1:“Acquire’ Button isan exception. The button is dimmed after the first execution if it is
unavailable.
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Navigating in Sharpdesk

Working with Sharpdesk isvery easy. It isdesigned to let you find your images and documents

quickly using the Folder Window, the Menu Bar, and the Tool bar.

Working with the Folder Window
By default, the Folder Window appesars at the left on the Sharpdesk screen. The Folder Window
can be used much like Windows Explorer to locate and display information from Sharpdesk, your
hard disk, or any connected network drives.

Using the Folder Window, you can display both the hierarchy of your Folder/Drive contents and
theindividua contents of each selected folder in the work area. Click on afolder to display the
files contained in that folder in the work area.

Use the Folder
Window as you woul
Windows Explorer to
locate, select and
manage your
documents.

el

----- [T Impartant Documents

-5 My Documents
=124 My Computer
=4 3% Floppy [4:)
SR= (5

@ My Docurnents

-] Program Files
&[] Sharpdesk Desktap
=1 Windaws

-0 A0 U gers

F-] Application D ata
#-_1 Catroat

#-_1 Cammand

-7 Config
-7 Cookies

-7 Cursars
-] Drwatzon
H-3] Favorites
-7 Fontz
D Help
F-C Java
-7 Media

- Options
[ =13

Sharpdesk Folder Window

] Expenze Hepc:\

\\ Sharpdesk Desktop

contains files and
documents that you use
often or are important to
you.

-
4| | v

Note : Sharpdesk does not display the files or folders that are present on the Windows' Desktop.

Note: Deleting or renaming system files or folders may cause Windows or other applicationsto
become unsgtable. Do not delete or rename files or folders without understanding what can occur.

14
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Right-Click Options
Right-click on afolder in the Folder Window to display a popup menu with Explorer-like menu
optionsthat let you perform the following actions:

New Folder — creste anew folder at the current location.

Rename — rename the selected folder.

Delete— dd ete the selected folder into the Windows recycle bin.
Copy — copy the contents of the selected folder into the Clipboard.
Paste — paste the contents of the clipboard at the current location.
Properties— display property information for the selected folder.

Right-click in the Work Area (away from any documents) to display a popup menu with Explorer-
like menu optionsthat let you perform the following actions:

Scan Document — displays the Scanning dialog box that |ets you set scanning options and
then scan an image into Sharpdesk.

From Scanner or Camera... (for Windows X P systems ONLY) — displays the Select Device
dialog box to let you pick a scanner or camera. Then it displays the Scanning dialog box for
the selected Device. From there, you can choose the scanning options for the WIA device
and finally scan the image into Sharpdesk. (If only one WIA deviceisinstalled, the Select
Devicediaog will be skipped, placing you directly in the Scanning dialog box for the WIA
device)

Paste — paste the contents of the Clipboard at the current location.
Select All — sdlect al documentsin the current folder.
Arrange — arrange thumbnails by Name, Date, Size, or Type.

Preferences— set preferences for displaying thumbnails, names for new scanned files, text
conversion and image export resol ution options.

Right-click on adocument in the Work Areato display a popup menu with Explorer-like menu
optionsthat let you perform the following actions:

Open — openthe selected file. If areadableimageis selected, it opensin Imaging.
Copy — copy the sdlected files to the clipboard.

Delete — ddlete the selected file into the Windows recycle bin.

Rename — rename the selected file.

Send As— attach the selected file to amail message using default email client on the user’s
PC. If the sdlected fileis an .SDF file, and the PDF format is selected, thefileisfirst
converted to PDF format before starting the email client. Only .SDF files may be converted
to PDF format before they are sent.

Properties— display property information for the selected file.

Sharpdesk User’s Guide 15



The Sharpdesk Menu
The Sharpdesk menu provides you with the following options:

FILE MENU DESCRIPTION

New Folder Create anew folder at the current location.

Open Open the currently selected file or folder. If areadable imageis selected, it opens
in Imaging.

Rename Lets you rename a selected file or folder.

Delete Delete the currently selected file or folder into the Windows recycle bin.

Print Print a selected file by opening its native application and causing it to print to the
current system default printer.

Acquire Image Displays the User Interface from the TWAIN driver (which will be different for
each scanner) that lets you set various options and then scan an image into
Sharpdesk. For more information, refer to “Chapter 5, Scanning with
Sharpdesk.”

Select Scanner Select aTWAIN scanning driver for use in scanning images and documents.

From Scanner or Camera..

(for Windows X P systems

Displays the Select Device dialog box to et you pick a scanner or camera. Then
it displays the Scanning dialog box for the selected Device. From there, you can
choose the scanning options for the WIA device and finally scan the image into

ONLY) Sharpdesk. (If only one WIA device isinstalled, the Select Device dialog will be
skipped, placing you directly in the Scanning dialog box for the WIA device.)
For more information, please refer to " Chapter 5, Scanning with Sharpdesk.”

Send As Attach the selected file to amail message using the default email client on your
PC. If the selected fileis an .SDF file, and the PDF format is selected, thefileis
first converted to PDF format before starting the email client. Only .SDF files
may be converted to PDF format before they are sent.

Properties Display property information for the selected file.

Exit Exit and close Sharpdesk.

EDIT MENU DESCRIPTION

Copy Copy the currently selected file or folder to the clipboard.

Paste Paste the contents of the clipboard at the current location.

Select All Select all documentsin the current folder.

VIEW MENU DESCRIPTION

Folders Toggle the default folder view on and off.

Toolbars Togglesthe Toolbar, Text Labels, and Large Buttons on and off.

Status Bar Toggle the status bar on and off.

Output Zone Toggle the display of the Output Zone on and off.

Refresh Refresh the thumbnailsin the work area.

Arrange Arrange thumbnails by Name, Date, Type, or Size.

Next Page If the thumbnail has more than one page, view the next one

16
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Previous Page

If the thumbnail has more than one page, view the previous one

Launch Explorer

Launch Windows Explorer.

TOOLS MENU

DESCRIPTION

Product Configuration Configure your Sharp-connected devices.

Preferences... Set preferences for displaying thumbnails, names for new scanned files, text
conversion and image export resolution options.

Composer Launch Composer component of Sharpdesk.

Imaging Launch Imaging component of Sharpdesk.

INTERNET DESCRIPTION

Sharp Product Information Display the Internet page connected to Sharp Product Information.

HELP DESCRIPTION
Contents and Index Display the Sharpdesk online help.
About Sharpdesk Disgplay Sharpdesk product version and copyright information.

The Sharpdesk Toolbar

The Sharpdesk toolbar allows you quick accessto key commands and additional Sharpdesk
applications such as Composer and Imaging.

To display apopup tip for acommand, move the mouse dowly over itsicon.

= & = [4] EE R Y
Open Acguing Copy FPazte Composzer |maging Arrange E xplorer
Sharpdesk Toolbar

The toolbar |ets you perform the following functions:

FILE MENU DESCRIPTION

Open Open the currently selected file or folder. If areadable imageis selected, it opensin
Imaging.

Acquire Displays the User Interface from the TWAIN driver (which will be different for each
scanner) that lets you set various options and then scan an image into Sharpdesk. For
more information, refer to “ Chapter 5, Scanning with Sharpdesk.”

Copy Copy the currently selected file or folder to the clipboard.

Paste Paste the contents of the clipboard at the current location.

Composer Launches Composer, |etting you combine pages from multiple documentsinto a new
Sharpdesk document. For more information, refer to “Chapter 7, Sharpdesk Composer.”

Imaging Launches Imaging, allowing you to view documents and images. For more information,
refer to “ Chapter 8, Sharpdesk Imaging.”

Arrange Arrange a selected folder display in the work areaby Name, Size, Type, or Date. The
current selection will be used to sort the thumbnails of every folder selected.

Explorer Start Windows Explorer.
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The Sharpdesk Output Zone

The Sharpdesk Output Zone lets you perform functions by simply dragging and dropping a
sdlected file to the appropriate Output Zone button. You can also highlight afile and click the
desired Output Zone button. To change the destination of an Output Zone button, click the “ down
arrow” toitsright and select another choice from the drop-down menu that appesars.

2

=
!
s

=
= £l

Output Zone

The Output Zone, when enabled, appears at the right of the Sharpdesk Work Area. The Print, Fax,
and eMail buttons appear if your computer has the supporting softwareinstalled. For instance, if
you do not have a Fax driver (‘fax’ somewherein its name) installed the Fax button will not
appear. Thesameistruefor theeMail button if your computer does not have a MAPI-compliant
email client installed:

LABEL DESCRIPTION

Print Prints asingle copy of the image to your default printer. To print to
ancther printer, click on the Down Arrow and select the desired printer.

Fax Sends the image/document to the host-resident fax utility allowing it to be
transmitted over atelephoneline.

E-mail Launches your e-mail application inserting the selected image/document
as an attachment.

Convert by OCR Sends the image/document though the OCR (Optical Character
Recognition) engine displaying it in the selected editor (see the next
section for more information).

Composer Prints the document using the Sharpdesk Composer print driver and
opens Composey.
Application Allows you to access other applications from the Output Zone. In the

example above, Microsoft Paint has been added to the Output Zone. To
add an application to the Application button, use the Tool s/Preferences
menu item described later.

Exiting Sharpdesk

To exit and close Sharpdesk, choose the Exit command from the File menu.
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Chapter 4
Working with Sharpdesk

Introduction

Sharpdesk makesit easy to identify, locate, and organize your files. This chapter reviews how to
work with each of the options Sharpdesk provides.

Viewing Images and Documents

When you open afolder in Sharpdesk, you view the documents contained in the folder asa
thumbnail of the document. If the number of documents within afolder exceedsthe available
work area, horizontal and/or vertical scroll bars appear. You can use them to scroll through the
work areato view al the documents.

Sharpdesk User’s Guide 19



Working within a Folder

On the Folder Window, click on the desired folder. The documents contained in the folder are
displayed in thework area. Each of your documents appears as a thumbnail image, showing the
file'sname and type. Note that it takes longer to generate thumbnailsthe first time afolder is
selected. If you click athumbnail while this process is happening, the generation process stops and
you can start using afile. However, the remaining thumbnails are left gray.
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Viewing Files as Thumbnails

To page through a multi-page document, click on the document to select it, and then click on the
arrows on ether side of the thumbnail. Or, use the Next Page or Previous Page optionsin the View
menu. You can see up to the first 20 pages of the document as thumbnails. When you move to the
second page of amulti-page document, Sharpdesk will “look ahead” up to 20 pagesto be ready for
the next page request. The caption of the thumbnail containsthe cur r ent page number and the
total page count of the document (up to 20 pages. If there are more than 20 pages, the total page
count will be represented as“20+”.) When you get to the 20" page of amulti-page document,
further clicksto the next page will beignored. You can page back to the front of the document
using the left arrow or the Previous Page option on the View menu.

The work areais automatically arranged according to the selected option from the Arrange tool bar
button. You can arrange thumbnails by Name, Date, Size (of the imagefile), or Type. Whenever
new documents are added to the work area, the thumbnails will be rearranged according to the
current setting of the Arrange option, with the new document occupying the appropriate place.

If the document cannot be rendered as athumbnail, it will be shown in the work areain the
following manner:

20
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If the thumbnails do not appear as expected, select the Refresh command from the View to correct
the problem.

Controlling the Desktop Display
Sharpdesk lets you customize the Desktop according to your preferences:
Choose the Preferences command from the Tools menu and click on the Desktop tab.

Preferences Ed

Desktop | E:-:pu:urtl .-’-'-.u:quirel Conwert By OCR I
— Thumbnail Settings

' Small Select a thumbnail dizplay zize.
' Medium

— Output £one Application Settings

Add or remove applications
from the output zone

Add

EEmEyE |

— Folder Settings
¥ Femember last folder when Sharpdesk. opens

Ok I Cancel Sl Help

Desktop Display Options

Changing the Thumbnail Size
To change the thumbnail size, click on your preference: Smdl, Medium, or Large. Then click OK.
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Adding/Removing an Application on the Output Zone

The current applications available on the Output Zone are listed in the box. To add an application
to the Output Zone, click the Add button and enter the path to the program you want placed on the
Output Zone. Or use the Browse button to |ocate and select the program. Then click OK.

To remove an application from the Output Zone, select its name from the box and click on the
Remove button. Then click OK.

Set up Sharpdesk Entry Folder

If you always want to enter Sharpdesk with the Sharpdesk Desktop folder displayed, uncheck the
‘Remember last folder...” box. If you want to enter Sharpdesk with thelast folder you werein
displayed, check the ‘ Remember last folder..."” box. Then click OK.

Setting Export Options

Both Sharpdesk and Sharpdesk Composer permit attaching and sending filesviaemail. In
addition, Sharpdesk Composer alows you to export Composer files as Adobe Acrobat (.PDF)
format files. (See “Menu Options’ and “ Attaching a Document to Email” in the “Working With
Composer” section in “Chapter 7: Sharpdesk Composer” for more details.)  If your workstation
has alimited amount of memory, converting alarge image to a300 dpi PDF file can take
considerable amount of time. Or if you wish to send alargefile viaemail, converting that fileto a
300 dpi PDF file and sending it may strain the resources of either your or the recipient’s email
application or may exceed size restrictions placed on email attachments by some Internet Service
Providers. In such cases, it may be helpful to modify the default image Export resolution settings.
To do 0, select Preferences from the Sharpdesk Tools menu and click on the Export tab.
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Export Resolution Settings
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Changing the Default Export Resolution

To change the default Export resolution, press and hold the left mouse button on the dider bar in
the Quality Settings frame and drag it until the dider bar indicates that the desired image
conversion resolution has been selected. Dragging the dider to the left will result in shorter
conversion times and smaller file sizes after conversion. Dragging the dider to the right will result
in higher quality images. When finished, click OK to save your selection.

Changing Color Settings

If obtaining asmall file size is more desirable than color reproduction for your exported files,
sdlecting the “Black and White” setting will create the smallest possible file during the export
process. Selecting the “Color” setting generates more accurate color reproduction of exported
documents. When finished, click OK to save your selection.

Viewing a Document’s Property Details

The Properties dialog box displays detailed information about a document. To display
properties information:

1. Click the mouse on the document for which you want to view detailsin the work area, and
choose Properties from the File menu.

2. Toclosethe Properties dialog box, click OK.

Contract_tif Properties EH |

General | TIFF Summary | Image |

Contract. tif

Type: TIF Image Document
Location: C:h\Sharpdesk Desklop
Sizen Z21KE [226.934 bytez)

MS-DO0S name:  COWTRACT.TIF

Created: Friday, April 11, 2003 10:04:53 Akd
t odified: Saturday, April 07, 2000 3:54: 38 Ak
Arcceszed: Friday, Apnl 11, 2003
ittributes: i [ Hidden

W Archive ™| Sustem

] I Cancel Sl

Properties Dialog Box
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Organizing Files
With Sharpdesk, organizing your files could not be easier. This section reviews the overdll
procedures for such tasks as selecting files, opening them, moving them, and deleting them. Note

that while Sharpdesk can page through afile's pagesin thumbnails, it is not possibleto isolate a
single page within afile. All operations, including cut, copy, and paste, apply to the entirefile.

Selecting Files
To work with afile, you must first select it in the Sharpdesk work area. To select afile:
*  Withthefiledisplayed in the work areg, click on it.

*  Tosdect multiplefiles, hold down the Ctrl key and click on the files you want to select, or
hold down the Shift key to select a continuous range of files.

Once sdlected, you can then choose the command for the task you wish to do such as open the
document, convert it to text by OCR, or print it.

Opening Files
You can open adocument in its parent application (the application used to originaly create the
document) or, if it is an image document, in the Sharpdesk Imaging.

To open afile using its parent application:

* Right-click on the document and choose Open, or,
*  Choose the Open command from the File menu, or,
» Double-click the image/document in the work area.

Deleting Files

To delete afile, right-click on it in the work areaand choose the Delete command. Or pressthe
Delete key on your keyboard (you can also select this command from the File menu). Thefileis
removed from Sharpdesk into the Windows Recycle Bin.

Restoring a File
To restore addeted file, click the Windows Recycle Bin folder, then right-click on thefile and
sdlect the Restore option. For more information on restoring files from the Windows Recycle Bin,
refer to your Windows online help.
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Moving Documents and Folders
You can move a document or folder from one folder into another folder asfollows:

1. Sdect the folder/document you want to move from the Folder Window or the work area by
clicking onit.
2. Drag and drop the folder/document to the new location.
You can aso drag-and-drop files and folders between Windows Explorer and Sharpdesk using the
above procedure.

Copying a File
A file can be copied from one folder to a different folder.
To copy afilefrom onefolder to another:
1. Openthefolder with thefile you want to copy.
2. Dragthefile, while holding down the Ctrl key, to the desired folder.

Renaming a File
You can change the name of afileto something else.
Torename afile:
1. Right-click on thefile you wish to rename.
2. Choose the Rename option (this command can also be sdlected from the File menu).

3. Typethe new namefor thefile.
4, Click outside the selection box to save the file with its new name.

Attaching a Document to Electronic Mail (Email)
If you use aMAPI-compliant e-mail application (such as Microsoft Exchange®), you can attach a
document or image to an e-mail message. Sharpdesk opens your e-mail application and attaches
the selected document to a blank e-mail message. You cannot open your e-mail application directly
from Sharpdesk if you don't plan on attaching a document.

To attach adocument or image to an e-mail message, click on the document you want to attach
and then choose the Send As option in the File menu.
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Chapter 5
Scanning with Sharpdesk

Introduction

Sharpdesk lets you scan documents directly into Sharpdesk. Once loaded into Sharpdesk, you can
use Imaging to look at them. Scanned images can a so be converted to text, allowing you to edit
them with common word processors. All scanned images are stored in a TIFF format.

This chapter provides instructions on setting and changing scan options.

Scanning Documents

Using your scanner, you can scan any document into afolder designated by Sharpdesk. The
resulting document can be displayed in Sharpdesk, as athumbnail image, or in Imaging, asafull-
Szed image.

Each image you scan is placed in afolder as a TIFF document. Theimageis stored and named
using the method defined in the Preferences option on the Tools menu in Sharpdesk.

A scanned document can be viewed, printed, or sent as an e-mail attachment.
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To scan an image from aTWAIN scanner:
1. Place the image you want to scan in your scanner.

2. In Sharpdesk, click the Acquire icon on the toolbar, or choose the Acquire Image command
from the File menu (to select a scanning device, choose the Select Scanner command from the
File menu).

To scan an image from aWIA scanner:
1. Placetheimage you want to scan in your scanner.
2. Sdect "From Scanner or Camera..." from the File menu in Sharpdesk.
3. Sdect ascanning device. (If only one WIA deviceisingtaled, this step is skipped.)
4. Set desired scanning options and then click the Scan button on the scanning dial og box.

To scaninimage fromaWIA camera
1. Sdect "From Scanner or Camera..." from the File menu in Sharpdesk.
2. Sdect your WIA camerafromthediadlog. (If only oneWIA deviceisingdled, thisstepis
skipped.)
3. Sdlect the picture you want to copy.
4. Click the"Get Pictures' button on the dialog box.

Note that the Scan dialog box is part of the software that comes with your scanner or camera. It
will vary depending on the manufacturer and mode of the scanner. Follow the specific
instructions that come with your scanner or camerato complete the scan of an image into
Sharpdesk.

Setting Scanning Options

In most cases (depending on your scanner), you should be able to specify the following scanning
options:

1. Preview the document prior to scanning.

2. Select an areaof the document from which to scan, typically by dragging the mouse over the
area, creating an outline of the selected area on the screen.

3. Tdl the scanner to send the image to your computer.

Usudly, a“scanin process’ dialog box appears, showing you the current progress of the scan.
When the scanning completes, the dialog box will usually disappesr.

Viewing Scanned Images

Once you have scanned an image into Sharpdesk, you can then view it or print it. Toview a
scanned image, click the folder containing the image in the Sharpdesk Folder Window. Your
scanned images are displayed as thumbnailsin thework area.
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Viewing an Image

To view a scanned image, click on the image and click on the Imaging button on the
Sharpdesk toolbar. Sharpdesk Imaging starts and displays the selected image.
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Image View in Imaging

For more information about viewing an image, refer to “ Chapter 8, Sharpdesk Imaging.”
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Changing Scanning Options

You can change the default naming convention used for new scans asfollows:
1. Choosethe Acquire tab from the Preferences dialog box in the Tools menu.

Preferences

Desktu:upl Export  Acuire | Correert By OCH I

Set optiong for automatically naming image files acquired from
your TN zzanner. File names will be appended with a
zequence number.

— File Hame Prefires

™ Cument D ate Formats |U4-11-EDD3 j

% Custom Prefis IImage

L PSR

Example: Image [2] ...etc.

—JPEG Compression

s
?l
o

Low High

k. I Cancel N 1 Help

Acquire Tab

2. TouseaDate asthe name for new scans, click the button beside “ Current Date Formats’, and
then select a date format from the drop-down list.

3. TouseaFilePrefix asthe new scan name, click the button beside “ Custom Prefix”, and then
enter the prefix you want to use.

4. To control the amount of compression used when scanning JPEG images, move the dider bar
in the desired direction. Generdly, the higher the compression, the lower the quality of the
resulting image.

5. After setting your options, click OK.
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Chapter 6
Converting Images to Text

Introduction

Sharpdesk lets you convert a non-editable, graphical image containing text into afile that can be
edited by your favorite word processor. You can convert an image at anytime while working in
Sharpdesk by smply dragging the image onto the Convert by OCR option on the Output Zone bar.
With Sharpdesk, even your document layouts are preserved.

Once an image has been turned into an editable document, you can then changeit, annotate it, and
treat it like any other document you crested from scratch in its native application.

You can convert any .TIF, BMP, .DCX, .JPG or .PCX, imageinto one of many standard output
formats. Once converted, the document can be edited by many word processors.

Keep in mind that text conversion accuracy depends on the qudity of the origind image. A poor
quality fax or copy might not convert correctly asthe engine will have difficulty reading the text
characters. On the other hand, most laser-printed documents should convert just fine. For tipson
getting the best results, refer to “Text Conversion Tips® later in this chapter.

Conversion Capabilities

The Sharpdesk conversion engine can recognize text charactersin the following languages:
English French German Italian
Spanish Portuguese Swedish Dutch
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Convert an Image using Drag-and-Drop

To convert an imageto text using drag and drop:
1. In Sharpdesk, select the image you want to convert in the Sharpdesk work area.

2. Make sure the Output Zone bar appears by selecting the Output Zone command from the
View menu.

3. Dragand drop the image onto the Convert by OCR option on the Output Zone bar. A didog
box appears showing you the progress of the conversion.

Convert To Text Progress |

File Mame: Contract kf @

Fecognizing test...

I

Fage 2 of 3

I

OCR Processing Screen

Thisdialog box shows you the name of the file being converted, the current conversion process
(auto-rotating, de-skewing, locating and recognizing), and the progress of the entirejob. Oncethe
conversion completes, the dialog box automatically closes and the finished text document appears
in the appropriate application. If you click Cancel, the ongoing conversion processis canceled.
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Convert by OCR Properties

You can OCR an image and specify the options you wish to employ.

To change text conversion preferences, choose the Preferences command in the Tools menu. The
Convert By OCR Properties didog box displays.
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Convert By OCR Properties Dialog Box

You can specify the following text conversion options. When you are satisfied with your
sdlections, click OK to save your options.

When you complete your selections, click OK to save your preferences for future scans.

OPTION/SETTING DESCRIPTION
File Format Select afile format that the conversion should use for its output.
Locate Method This option controls the method that the text conversion engine usesto locate

text on apage. You can select from:

Normal (Multi-Column): This setting is suitable for most cases. It isto be used
on text with ordinary paragraphs, pages with mixed text and graphics, and on
multi-column pages of text such asin newspapers and magazines. This setting
isaso good for pages that have tables.

Force Single Column: Use this setting when the page contains side-by-side
blocks of text that you want the text conversion engine to read from left to right
across the page. With this setting, the engine always locates text from the left
margin to the right margin of the page, regardless of the spacing between
groups of words.
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Picture Processing

This setting determines whether to look for text within pictures. Your choices
are

Text & Pictures: Use this setting when you want the text conversion engine to
attempt to locate text that resides in regions on the page that it views as
pictures.

Text Only: The text conversion engine does not attempt to locate text that
resides in regions on the page that it considers to be pictures.

Quality of
Input Image

This setting tells the text conversion engine about the qudity of theimageit is
about to process. Your choices are:

Letter: Thisis appropriate for most documents.

Dot Matrix: Usethis setting when charactersin the input document are printed
in amono-spaced font and made up of dots that are not touching.

Degraded Quality: Check thisitem when the input text is severely degraded or
ishard to read. Thiswill significantly slow down the text conversion
processing.

Miscellaneous

Custom Dictionary: Clicking this button invokes a standard File Find dialog
box letting you select a custom dictionary file (.DIC). Custom dictionary files
improve the recognition ability when processing uncommon words. Sharpdesk
comes with asimple custom dictionary, USER. DI C, that will be selected by
default. If you are converting a document that contains technical terms that
aren’'t commonly used, you can place these termsin ayour custom dictionary
separated by line breaks. Use Microsoft® Notepad or other similar editorsto
make changes to your custom dictionaries or create new ones.

Language: Letsyou select alanguage setting for the text conversion engine.

Illegible Character: Lets you specify the character that the text conversion
engine outputs when it cannot read a character. The default is“~".

Show thisdialog box every time OCR is performed: Checking thisitem
forces this property dialog box to be displayed every time you perform OCR,
giving you an opportunity to change the settings.

Text Conversion Tips

If you do not get the results you want when you convert an image to text, you might check the

following items:

*  Check your scanning options. You might have the brightness or contrast levels set too high

or too low.

*  Check your text conversion preferences.

*  Clean your scanner glass and scanner lid with a soft cloth.

*  Repostion the document on the scanner glass.

*  Change your Quality of Input Image settings. Sometimes an image can be converted by
using the Dot Matrix or Degraded Quality settings.

* Besureyou have sufficient disk space to hold the temporary files that the text conversion

engine creates.
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Chapter 7
Sharpdesk Composer

Introduction

Using Sharpdesk Composer, you can combinefiles of different typesinto a single production-
ready document. For example, you could combine aWord file with an Excd file, and then even
add inaLotusfile. Composer lets you reorder pages, add a cover page or inserts, and then print,
copy, or e-mail the entire document. You can load as many source documents as you need to create
the new document.

The Composer eiminates the need to cut and copy documents from multiple applications. If you
can print from an application, you can usualy add the document to the Composer and create any
document collection that might be required. Documents are added to Composer by dragging and
dropping them into Composer’swork area or the Composer button on the Output Zone.
Documents can aso be added to Composer by printing from the application that created the file
through the Sharpdesk Composer printer driver. The following applications have been tested with
Composer, with the indicated results and limitations.
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Support direct print

Application Version |Support Drag & Drop? | from Application?
Adobe Acrobat Reader 4.0 Yes (Note 1) Yes
Adobe Illustrator All Margina (Note 2) Margina (Note2)
Adobe Page M aker All Not Supported (Note 3)  |Not Supported (Note 3)
Adobe Photoshop 5.0,55 Not Supported Yes
cc Mail 82-85 Not Supported Yes
Corel Presentations 8.0,9.0 Yes Yes
Corel Quattro Pro 8.0,9.0 Yes (Note 4) Yes
Corel WordPerfect 8.0, 9.0 Yes Yes
Imaging for Windows 20 Yes Yes
Lotus 123 97, 2000 Y es (Note 4) Yes
L otus Freel_ance 97, 2000 Yes (Note 5) Yes
Lotus WordPro 97, 2000 Yes Yes
MS Access 07, 2000, XP Not Supported Yes
MS Excel 97, 2000, XP Y es (Note 4) Yes
MS Internet Explorer 4.0,5.0 Yes Yes
M S Outlook 08, 2000, XP Not Supported Yes
M S PowerPoint 07, 2000, XP Yes Yes
MS Project 98, 2000 Not Supported Yes
MS Publisher 97, 2000 Yes Yes
MSVisio 5, 2000 Y es (Note 6) Yes
MS Word 97, 2000, XP Yes Yes
Netscape 4.0 Yes Yes
Pagis Millennium 2000 Yes Yes
PaperPort 6.0, 7.0 Not Supported Yes
Quark Express All Margina (Note 7) Margina (Note 7)
Notes:

1 Does not close the application after printing.

a b~ WN

Pages printed into Composer may be blank in some cases.
EPS output from Page Maker is not supported by Composer.

Only the sheet that was active when the file was closed is sent to Composer.

Color documents will be rendered as black and white. To retain color content, print

directly from FreeLance, following its directions for printing in color.

6 Page size and orientation may not be maintained correctly. Print directly from the
application to ensure proper orientation.

7 The application may get an error in Some cases.
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Starting Composer
You can gart the Sharpdesk Composer from Sharpdesk.
To gtart the Composer from Sharpdesk, click the Composer icon on the Sharpdesk tool bar.
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Sharpdesk Composer
Composer is comprised of the following elements:

Menu Bar
The menu bar contains commands that 1et you perform various tasks with your documents.

Toolbar
The toolbar provides you quick access to commands needed to save and close, send a page or
document as an e-mail attachment, print adocument, cut, copy or paste items and to delete pages.

Work Area
Thework arealets you create and arrange the pages of the final document.

Reference Area
The Reference section lists al source documents contributing to the document currently displayed
intheWork Area

Working with Composer

Pages are loaded into Composer by printing to the “ Sharpdesk Composer” driver from third-party
applications (for example, MSWord, MS Excel, and so on). Or, you can drag and drop afile from
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Microsoft Explorer directly into either Composer’swork areaor the “ Composer” button on
Output Zone of Sharpdesk. Loading pages with drag and drop uses the default paper size and
orientation. If the resulting pages do not appear as you wish, use the following optionsto ater the

result.

Loading Pages into Composer

To put pages into Composer from third-party applications:

1. Sdect the Print command from the application in which you are working. A screen similar to

thefollowing appears:
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Print Screen

2. Select Sharpdesk Composer asthe target printer. The Properties button displays options that
you may choose from. Pick the Paper Size and Orientation you want Composer to work with

and click OK.
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Paper Screen
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3. Click OK or Print (depending on the application you' re running) to start the print operation.
If Composer isnot currently running, it automatically starts and the new pages are added to an
Untitl ed. sdf document. If Composer isrunning with adocument in itswork area, the new
page(s) are added to the existing document. Continue the process of |oading pages into Composer
until everything desired has been included. Then use Composer to selectively delete or re-order
them into the finished document.

Creating Composer Documents

Working with Composer is easy and intuitive. Once your source documents have been loaded into
thework area, you can use the mouse or commands from the Menu bar and Toolbar to delete or
re-order pages to create the new document.

Manipulating Pages
*  Pages can be dragged and dropped within the Composition work areato re-order pages as
desired. To drop apagein the work area, release the mouse at the location where the pageis
to beinserted.

*  Each page inserted into the composition work area displaysits origina source file name.
* Toview afull-pageimage, double-click on the page.

Deleting Pages
1. Click on the page(s) you want to delete. (To select multiple pages, click on the additional
pages while holding down your keyboard's <Ctrl> key.) The currently selected page(s) will
be highlighted.
2. Click the Delete option on the toolbar, or the Delete command from the File menu or pressthe
Delete key on your keyboard. A confirmation message appears.

3. Click OK to delete the page(s).
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Menu Options

The Menu Bar contains the following options:

MENU DESCRIPTION

File

New Create a new main window with no referenced files.

Open Open an exigting Sharpdesk file.

Add Document Adds pages from a new document to the Work Area.

Save Save the current (modified) file.

SaveAs Save the current file under a new name.

Export Generate a PDF file from the current Composer document. (See Note 1)

Print Print the current page or all document pages.

Print Preview Display pages as they will look when printed.
NOTE : If non-scalable fonts are present, the Print Preview image may not
be exact..

Print Setup Select adefault printer and set basic print options (paper size, orientation,
and so on).

Send Mail Send the current document as an e-mail attachment in .PDF (Adobe Acrobat)
format. (See Note 1)

Properties Display the attributes of the current file.

Exit Close and exit Composer. If the document has been modified, you can save
the document prior to closing.

Edit

Cut Cut the selected page(s) from the document and place it on the clipboard.

Copy Copy a page from the document and placeit in the clipboard.

Paste Paste the contents of the clipboard at the current location.

Delete Remove a selected page(s) from the document.

Select All Select al document pages.

View

References Toggle the reference documentslist on and off.

Toolbars Toggle the toolbar on and off.

Status Bar Toggle the Status Bar on and off.

Tools

Reinstall Printer Driver

Reingtall the Sharpdesk Composer printer driver after deleting it using the
Start\Printers dialog provided by Windows.

Help

Contents and Index

Digplay the Composer help information.

About Composer

Display Composer copyright and version information.
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Toolbar Options
The Composer Toolbar lets you select commands quickly:

COMMAND DESCRIPTION

Add Doc... Adds pages from a new document to the current composition.

Save Save the current (modified) file

Send Mail Send the current document as an e-mail attachment in .PDF (Adobe Acrobat)
format. (See Note 1)

Print Print a document or selected pages.

Cut Copies a page from the document to the clipboard and removesit from the
document.

Copy Copy a page from the document and placeit in the clipboard.

Paste Paste the contents of the clipboard at the current location.

Delete Delete the currently selected page(s).

Note 1: Thedefault image export resolution may be modified prior to image conversion for the
“Export” or “Send Mail” options. See* Setting Export Options’ inthe“Viewing Images and
Documents’ section in “Chapter 4 —Working With Sharpdesk” for more details.)

Saving Documents

To save the new document, choose the Save command from the File menu. If you have previoudy
named and saved the document, it will automatically be saved. If thisisthefirgt time you are
saving it, a Save As dialog box displays |etting you name and save it.

Opening a Composer Document
You can open a Composer document as follows:

1. Choose the Open command from the File menu. The Open dialog box appears.
2. Navigateto the file you want to open and click Open.
Thefile opensin Composer.
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Attaching a Document to Email
You can attach a document to an e-mail asfollows:

e Point to the Send Mail command in the File menu, or

e Click on the Send Mail button on the toolbar.

Your email program is automatically launched and the document inserted as an attachment in
.PDF (AdobeAcrobat) format. (Note: the default image export resolution may be modified prior
to image conversion. See* Setting Export Options’ in the “Viewing Images and Documents’
section in “ Chapter 4 —Working With Sharpdesk” for more details.)

Closing Composer

To close the Composer, choose the Exit command from the File menu.
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Chapter 8
Sharpdesk Imaging

Introduction
Using Sharpdesk Imaging, you can view images, manipulate them, annotate them, and print them.

Basic Imaging Concepts

This section discusses some basi ¢ concepts and terminology to help you better understand
Sharpdesk Imaging.

What is Imaging?
Imaging can be described as using computer software to create, modify, and process el ectronic
images. Typical Imaging operationsinclude:
*  Scanning text, photographs, or drawings and saving the resultsin an imagefile.
* Digplaying images using techniques such as thumbnail representations, magnification,
rotation, and sizeto fit.
*  Sending image documents by e-mail or fax.
e Adding annotations to images.
*  Performing e ectronic cleanup of images to make them easier to view.

*  Combining several imaging operationsinto asingle, automated procedure that runs while
you perform other tasks.
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Types of Images

Animageisan electronic representation of atext document, a photograph, aline drawing, or other
graphical entity. You can create an image by scanning a printed page, a photograph, adrawing, by
saving afax, or by creating an image with adrawing or graphic-design program.

After apage of text is scanned and saved, it takes on the properties of an imagefile, and can no
longer be opened with aword processor or text editor.

Image File Formats

Images are saved asimage files, which usefile name extensons such as . TIF, .BMP, .JPG, and
AWD . The extension indicates the format used to store theimage.

Some formats, such as.BMP and .JPEG, contain just oneimage per file.
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Single Image File

Other formats, such as.TIFF and .AWD, are similar to abook. They contain one or more pages
with each page holding asingleimage.
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Multiple Image File
Because image files are standard Windowsfiles, you can use Windows commands to perform
operations such as:
*  Organizing filesinto folders
*  Attaching an imagefile to an e-mail message
e Copying, renaming, or deleting files
* Printing or faxing files

Image Documents

An image document is a collection of one or more imagesthat arelogically related. A smple
image document might be a blank form, scanned and saved in an image file format.
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Simple Image Document

Another image document could be a collection of faxes, memos, and photographs that are scanned
to amulti-pageimagefile.
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Multi-Page Image File

Sharpdesk Imaging

With Sharpdesk Imaging, you can perform avariety of imaging operations by making selections
from menus or by clicking on tool buttons.

Many options present diad og boxes. If you are not sure about which values or propertiesto set,
accept the default values. These values were chosen to give satisfactory resultsin avariety of
stuations. As you experiment with the different options and property settings, you can create
resultsthat suit your preferences.

Sharpdesk Imaging consists of the Imaging application and ActiveX controls. The Imaging
application is described in the following sections.

Imaging Application
This section briefly describes what you can do with the Imaging application. For more detailed

information, including how to perform specific tasks, refer to the on-line Help while using the
application.

Display Images
Imaging Application reads and displays the following types of image files:

IMAGE FILE TYPE EXTENSION
TIFF Document TIFR TIFF, JFX
Bitmap Image .BMP

Fax Document (Windows 95 and 98 ingtallations only) AWD

Image Bookmark File IBK

JPEG File JPG .JPE, .JPEG
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PCX/DCX Document

.PCX, .DCX

WIFF Document

WIF

XIF Document

XIF

You can display asingleimage in the window, display thumbnail views of the images contained in
amulti-page image document, or display an image page and thumbnails together.
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Imaging Window Dialog

Convert Image Files
Using Imaging for Windows, you can save a displayed image in one of the following formats:

« TIFF
« BMP
. JPEG

. AWD (Windows 95 and Windows 98 only)

In some cases, converting from one format to another causes the source image to permanently lose
certain attributes. For example, if you save acolor . BMPfileto . AWD format (which isblack and
white only), the saved image is converted to black and white. If you convert the AWD image back
to .BMP the color information that was lost in the first conversion cannot be recovered.

Change Image Display
You can change the image display by zooming to increase or decrease the size of theimage, by
sizing the image for the best fit, or sizing it to fit the height or width of awindow. You can also
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rotate an image lft, right, or 180 degrees. Rotating an image is useful if you scanned landscape
images using a scanner's sheet feeder, or if you fed a stack of documentsinto the scanner's
document feeder backwards (180 degrees from the desired orientation).

Thumbnail images can be made larger to display more detail, or smaller to fit more of themin the
window. You can aso drag and drop thumbnails to change the order of pagesin theimage
document.

Scan Images
You can create image documents by scanning forms, memos, pictures, or other paper documents
to animagefile.

Imaging for Windows Professional Edition supports TWAIN-compatible devices such as scanners
and digital cameras.

NOTE:
For best results, save scanned documentsin TIFF formeat.

Annotate Images
You can add a variety of markupsto an image by using Annotation features, and then save the
annotations with the image. Some types of annotations are:
* Freehand or straight-line markings
» Highlighter
* Hollow and filled rectangles
» Attach-a-note text
* Textfromafile
e Customizable rubber stamps such as “Received” or an image such as your company logo
*  Hyperlinks

Severa of these annotations have propertiesthat you can set, such as color, line width, and font.

A hyperlink is a specia type of annotation that you can link to afile, a Uniform Resource L ocator
(URL) on the World Wide Web, or to a page in an image document.

The document HQ.TIF isincluded in the Samples folder of this product. This example of an
annotated document page includes hyperlinks to other pages within the document. Click on the
text within the rectangles drawn on the map to jump to the photographs on pages 2 and 3 of the
document. Click on the designated area of the street address on the map to jump to Eastman
Software's Homepage on the World Wide Web.
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next to a
thumbnail's
page number,
it means the
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Annotating an Image Dialog

Create a Contact Sheet

You can create a contact sheet that contains athumbnail rendition of each page of an image
document; similar to a photographic contact sheet that displaysimages of each negative on aroll
of film. Before you create the contact sheet, you can globaly set the thumbnail size [ larger to
display more detail, or smdler, to fit more thumbnails onto the contact sheet.

Image Processing
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Contact Sheet Dialog

During scanning and faxing, documents can pick up small speckles of dust that degrade theimage.
The Remove Speckles option el ectronically processes the document to remove these.
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Using the Straighten Page option, you can straighten an image that is crooked in relation to the
background page. After you draw areference line on the displayed document, the application
rotates the image to the correct orientation.

You can specify aportion of the image to crop or let the program automatically crop the edges of a
displayed image for you.

Using the Imaging Application
This section guides you through some basi ¢ operations with Imaging Application. For additional
informeation, refer to the on-line Help.

Before You Begin
Before you perform the following exercises, start Sharpdesk Imaging:

1. Click the Start button.
2. Point to Programs, Sharpdesk, and Imaging.

Although some operations can modify the sampleimage filesinstalled with this program, the
original versons of these files are available on your installation CD.

Finding an Image Document
You can assign properties, such asAuthor, Keywords, Comments, Title, and Subject, to image
documentsin TIFF format. When you want to find documents on local or redirected drives,
specify one or more of these properties as the search criteria

Setting Properties
Perform the following steps to assign a property to an image document.

1. OntheFilemenu, click Open.

2. Navigate to the folder where you installed Sharpdesk Imaging. (The default locationis
C.\ Program Fi | es\ Shar p\ Shar pdesk\ | magi ng).

Open the Samplesfolder.

Sdlect the document HQ.T1F and then click Open.

Onthe File menu, click Properties. A tabbed diaog box appears.

Click the Summary tab. The Property fields appear and should be unfilled.

o 0~ W
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Setting Properties Dialog

Thisiswhere you type property values for your image documents. You may wish to standardize
the values you enter so that your documents are organized in a more useful way. For example,
descriptive Keyword entries could be Invoices, Deposits, Inventory, and so on. For thisexercise,
you will typein an arbitrary value just to see how the procedure works.

1. Inthe Subject field, enter Sample Image and then click OK. (These fields are not case
sengitive, however, be sure to include the space between the two words.)

2. Onthe File menu, click Save to add the property value to the document.

Finding Specified Properties
The following steps describe how to find image documents that have the property value you
specified.
1. OntheFilemenu, click Open. The Open dialog box appears.
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2. Click the Find button. The Find: Image Files dialog box appears.
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Find: Image Files Dialog Box

3. Inthe Subject fidd, enter: Sampleimage.

4. Typethe path to your Imaging folder, and then select the Include Subfolders box.
5. Click Find Now. The lower pane of the dialog box displays the names of documents with the

Subject property value “ Sample Image.”
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Sample Image Dialog Box

Notice that two documents met the search criteria; the document whose Subject property you set,

and another sample document.
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Displaying an Image Document

This section describes how to open an image document, change the display attributes, display and
resize thumbnails, and create a contact shest.

Opening the Document
1. Onthe File menu, click Open. The Open dialog box appears.

2. Navigate to the folder where you installed Sharpdesk Imaging. (The default locationis
C.\ Program Fi | es\ Shar p\ Shar pdesk\ | magi ng.)

3. Open the Samplesfolder.
4. Sdlect CHAPTERL.TIF and then click Open. Theimage of atext document appears.
5. OntheView menu, click on One Page.

Changing the Display
1. Changethe size of the display window in the vertical and horizontal directionsto suit your
preference.

2. On the Zoom menu, choose different options to resize the document to fit in the display
window. When you change the size of the document, its height to width ratio is maintained.

a) Click Fit to Height to view the full height of the document page.
b) Click Fit to Width to display the full width of the page.

¢) Click Pixel to Pixel. If the entire page does not fit into the display window, scroll
bars appear along the right side and/or bottom.

d) Click Best Fit. Thisis often the optimum setting.

3. On the View menu, click Page and Thumbnails. Thumbnails of pagesin the document are
displayed in awindow next to the page view. The selected thumbnail has aborder around it.

4. Position the pointer over the vertical bar separating the Thumbnail and Page windows and
picture. When the pointer changes shape, hold down the left mouse button and then drag the
bar |eft or right to resize each window.
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Sizing Windows Dialog Box

NOTE:
On the Tools menu, click Magnifier if you want to enlarge only a portion of the document page.
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Displaying and Changing Thumbnails
1. OntheView menu, click Thumbnails. the thumbnails are displayed.
2. Onthe Toolsmenu, click Options, Thumbnail Size. The Thumbnail Size diaog box appears.
[ -

P p———

Thumbnail Size Dialog Box

3. Placethe pointer over the handle in the lower right corner of the thumbnail, hold down the | eft
mouse button, and then drag the handle diagonally to increase or decrease the size of the
thumbnail.

4. Click OK to apply the new size to the displayed thumbnails.

Creating a Contact Sheet
1. OntheFilemenu, click Open. The Open dialog box appears.

2. Navigate to the folder where you installed Sharpdesk Imaging. (The default locationis
C.\ Program Fi | es\ Shar p\ Shar pdesk\ | magi ng.)

Open the Samplesfolder.

Select CHAPTERL.TIF and then click Open. The image of atext document appears.

On the Tools menu, click Create Contact Sheet. The Create Contact Sheet dialog box appears.
Type afilename (contact) and location (Samples folder) to creste thefile, and then click Save.

On the File menu, click Open, and then double-click on CONTACT.TIF to view thefileyou
created. Click on apageto view the origina page.

8. Click the Back button *| to return to the contact sheet.

You can choose to have your contact sheet automatically open after you create it. To have your
contact sheet automatically open after you cregte it:

1. Onthe Tools menu, click Options, and then Contact Sheet.
2. Onthediaog box, select the Open contact sheet after saving box.
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Annotating a Document

This section describes how to add annotations to a document, change annotation properties, and
save the annotated document.

Applying a Rubber Stamp
1. OntheFilemenu, click Open.

2. Navigate to the folder where you installed Sharpdesk Imaging. (The default locationis
C.\ Program Fi | es\ Shar p\ Shar pdesk\ | magi ng.)

3. Click the Samplesfolder.

4. Select theimage document ANNOUNCE.TIF and then click Open. The image document
appears.
5. Onthe View menu, click on One Page.

6. On the Annotation menu, click Rubber Stamps. The Rubber Stamp Properties dial og box

appears.
Hubdbei Slamp Piopedtes
Instead of
selecting from the Stamps:
[ T C
menu, you can L ieale Tel.
y A% DRAFT _I

click onatool in

. C _
the Annotation W,, ﬂl
toolbar - Daleie |

& g |

Rubber Stamp

‘Sample of bt slsmpe:

Received %x

™ Saicky [ o | E-rn::all

Rubber Stamp Properties Dialog Box

7. Inthe Stampslig, click Received, and then click the Edit button. The Edit Text Rubber Stamp

Properties dialog box appesars.
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Edit Text Rubber Stamp Dialog Box
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8. Click onthe Font button. The Rubber Stamp Font Properties dialog box appears.
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Rubber Stamp Font Properties Dialog Box

9. IntheCoalor lig, click Red and then click OK three times to close each dialog box. The pointer
changesto arubber stampicon.

10. Posdition the rubber stamp at the top of the document, and then press the left mouse button
once. The stamp annotation is applied to the document. You can move the stamp by placing
the pointer inside the dotted outline, and then by dragging the stamp to adifferent location.

11. Click outside of the dotted outline to anchor the stamp.

Adding a Highlight
1. Keep the document ANNOUNCE.TIF open to apply ahighlight annotation.

=)

Highlighter

2. Onthe Annotation menu, click on Highlighter. The pointer changesto a marker and crosshair.

3. Position the crosshairs dightly above and to the lft of a paragraph you want to highlight.
Hold the left mouse button down and drag the pointer across and down to the end of the
paragraph. Release the button to apply the highlight.

Changing Highlight Properties
1. Placethe pointer on the highlight and press the right mouse button. The shortcut menu
appears.
2. Click Properties. The Highlighter Properties didog box appears.
NOTE:

To change the default properties for an annotation, right click on the tool in the Annotation tool bar
or check the Set As Default pick in the Annotation Properties dialog box.
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3. Choose acolor, such aslight blue, that allows the text to show through. Click OK to apply the
new color.

Enhancing a Document
This section shows how to enhance a document page by despeckling and straightening.

Removing Speckles From a Document

1. OntheFilemenu, click Open.

2. Navigate to the folder where you installed Sharpdesk Imaging (the default locationis
C. \ Program Fi | es\ Shar p\ Shar pdesk\ | magi ng), and then click the Samples
folder.

3. Sdect the image document ANNOUNCE.TIF and then click Open. The image document
appears.
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Image Document

4. On the Zoom menu, click Best Fit.

5. On the Tools menu, click Remove Speckles. The application removes small speckles
introduced during the scanning or faxing process.

6. Keep this document open to perform the next task.
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Straightening the Page
1. OntheTools menu, click on Straighten Page. The Straighten Page dialog box appesars.

2. Movethedidog box to the side or bottom of the page, so you can draw areferencelinein the
top portion of the page.

3. Createareferencelinethat isdanted in exactly the same way asthetext. To do so, position
the pointer between two lines of text and press the left mouse button. While holding the
button down, drag the pointer to the right, paralld to the text above and below theline.
Release the mouse button when the reference line you have drawn is positioned correctly as
shown.
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To straighten the page, draw a line that pou want ko be
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ou know should be horizontal ar vertical.

Cancel Apply

Straighten Page Dialog Box

4. Click OK in the Straighten Page dialog box. The page rotates until the reference line you drew
is pardld with the top and bottom edges of the window.
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Chapter 9
Glossary

Introduction
The following terms and definitions can assist you when working with Sharpdesk.

A
ASCII

Acronym for American Standard Code for Information Interchange. A set of definitions for the bit
composition of characters and symbols. ASCII defines 128 symbols using 7 binary bitsand 1

parity bit.

Browser

The gpplication program, such as Microsoft's Internet Explorer, that lets you display HTML
documents.

Default Setting

A system setting incorporated at the factory and permanently registered to the application. Also, a
value or a setting that the software assumes until or unless you specify another value.

Devices
A deviceisapiece of hardware such as a scanner, printer, fax machine, digital camera or copier.

DPI
Dots per inch. A unit of measurement for indicating a printer’s resolution.
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Graphic

A written, printed, or dectronically displayed symbol or drawing. Also, characters or text that have
been generated by a computer graphics application program.

Grayscale

A color in black and white as aresult of different intensities of black.

Image

In Sharpdesk, an image is used interchangeably with Document. Commands and functions work
exactly the same regardless of whether theitemin questionisa.TIFfile, a.JPG file, or a.DOC
file.

Landscape Orientation

The horizontd orientation of your document or image across the length of the page. Theterm
landscape is derived from pictures of the landscape, which are usualy horizontal in format.

OCR

Optical Character Recognition. A technology that lets you turn a paper document into an editable
€lectronic document.

Output Zone

A Sharpdesk added toolbar alowing quick accessto print, fax, scan, email, and OCR an image.

Paper Feed
Movement of a sheet of paper into the printer’s paper path.

PC Fax

An eectronic way to send and receive faxes from your computer. A PC fax is sent from or
received by acompuiter.

Portrait Orientation

The verticd orientation of your document or image across the width of the page (Ietter style). This
isthe opposite of landscape orientation.

Printer Driver

Software that sends printing instructions to a printer. The printer driver keeps track of the
attributes of a printer and the codes a program must send to access those attributes.
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S
.SDF File
A Sharpdesk-created file that can be opened and edited in the Sharpdesk Composer.

TWAIN

Both a protocol and an application programmer’sinterface (API) that lets you input image data
directly from any source (for example: desktop and hand-held scanners, video capture boards,
digital cameras, and other imaging equipment) without requiring you to switch out of the
application. It provides compatibility between image input devices and applications by acting as
the liaison between hardware devices and software applications. TWAIN, the industry standard,
was devel oped by the TWAIN working group which consists of representatives from many leaders
in the scanner hardware and software industry.

Sharpdesk User’s Guide 61



	Chapter 1 Introduction
	Overview
	System Requirements
	About This Guide
	User’s Guide Organization
	Definitions of Terms
	Sharpdesk Online Help

	Chapter 2 Installing Sharpdesk
	Installation Procedure
	Software Location
	User File Location
	Sharpdesk CD Installation

	Uninstalling Sharpdesk

	Chapter 3 Sharpdesk Overview
	Introduction
	Starting Sharpdesk
	Menu Bar
	Folder Window
	Toolbar
	Work Area
	Output Zone
	Status Bar
	Scroll Bars

	Navigating in Sharpdesk
	Working with the Folder Window
	Right-Click Options

	The Sharpdesk Menu
	The Sharpdesk Toolbar
	The Sharpdesk Output Zone

	Exiting Sharpdesk

	Chapter 4 Working with Sharpdesk
	Introduction
	Viewing Images and Documents
	Working within a Folder
	Controlling the Desktop Display
	Changing the Thumbnail Size
	Adding/Removing an Application on the Output Zone
	Set up Sharpdesk Entry Folder

	Setting Export Options
	Changing the Default Export Resolution
	Changing Color Settings

	Viewing a Document’s Property Details

	Organizing Files
	Selecting Files
	Opening Files
	Deleting Files
	Restoring a File
	Moving Documents and Folders
	Copying a File
	Renaming a File
	Attaching a Document to Electronic Mail (Email)


	Chapter 5 Scanning with Sharpdesk
	Introduction
	Scanning Documents

	Setting Scanning Options
	Viewing Scanned Images
	Viewing an Image
	Changing Scanning Options

	Chapter 6 Converting Images to Text
	Introduction
	Conversion Capabilities
	Convert an Image using Drag-and-Drop
	Convert by OCR Properties
	Text Conversion Tips

	Chapter 7 Sharpdesk Composer
	Introduction
	Starting Composer
	Menu Bar
	Toolbar
	Work Area
	Reference Area

	Working with Composer
	Loading Pages into Composer
	Creating Composer Documents
	Manipulating Pages
	Deleting Pages

	Menu Options
	Toolbar Options
	Saving Documents
	Opening a Composer Document
	Attaching a Document to Email

	Closing Composer

	Chapter 8 Sharpdesk Imaging
	Introduction
	Basic Imaging Concepts
	What is Imaging?
	Types of Images
	Image File Formats
	Image Documents

	Sharpdesk Imaging
	Imaging Application
	Display Images
	Convert Image Files
	Change Image Display
	Scan Images
	Annotate Images
	Create a Contact Sheet
	Image Processing

	Using the Imaging Application
	Before You Begin
	Finding an Image Document
	Setting Properties
	Finding Specified Properties

	Displaying an Image Document
	Opening the Document
	Changing the Display
	Displaying and Changing Thumbnails
	Creating a Contact Sheet

	Annotating a Document
	Applying a Rubber Stamp
	Adding a Highlight
	Changing Highlight Properties

	Enhancing a Document
	Removing Speckles From a Document
	Straightening the Page



	Chapter 9 Glossary

